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 President        Michael Moore 714-535-0608  president-bod@ocipug.org
 Vice President       David Wintle 949-548-7994  allart@pacbell.net
 Secretary       Frank Mastroly 714-960-9472   fmastroly@earthlink.net
 CFO/Treasurer        Leonard Stein 949-454-0158   leonard stein@netscape.com

      Director 2003        Red Davidson 949-548-0413   red.d3@juno.com
 Director 2003        Ed Leckliter 310-944-6453.   eleckliter@adelphia.net
 Director-2003-2004       Morris Fier 949-646-8292  morris_ fier@yahoo.com
 Director-2003-2004       Sandi Tierney 714-648-2218   gadgetgoddess2002@hotmail.com
 Past President       Leonard Stein 949-454-0158   leonard stein@netscape.com
 Webmaster        Mark Borison 714-963-8296   mborison@yahoo.com

      Readme.Doc Editor       Robert Walker 949-642-5997   rwalker820@msn.com

OCIPUG Web Page:  www.ocipug.org OCIPUG Information line:   714-535-0608

           .

Special Interest Group (SIG) meetings
are held monthly as follows:

 1st Tuesday          7:00 PM - Internet
 2nd Tuesday        7:00 PM - Hardware
 3rd Tuesday         7:00 PM - Windows
 4th Tuesday          7:00 PM - Digital Photo

Meetings of the Executive Board will
be held after the General Meeting
12:15-1PM

All OCIPUG members are welcome.

president.bod@ocipug.org
            OCIPUG E-mail

General Meetings are held  from
9:00AM to noon on:

20 December                2003
24 January                   2004
21 February                 2004

20 December                2003
24 January                   2004
21 February                 2004

Don Edrington is a Teacher, Author, Senior Tutor, Colum-
nist (both in print and on the web) and talk about sites
that contain good info, he has everything  from great tips
to useful  keyboard shortcuts, and seasonal and inter-
esting art to fascinating stories. He can show you how
Using a PC Can Be Hazardous to Your Health.

He has written a virtual cyber Autobiography and it really
shows people the various ways that one can utilize a web
page to express themselves.

                                       Christmas Potluck

December 20 Program
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SPECIAL INTEREST GROUP
(SIG)

(All Special Interest Group (SIG) meetings  are held at
the Costa Mesa Senior Center on the southeast corner
of 19th and Pomona at the times noted below.) The
next SIG metting will be:

SCHEDULES AND REPORTS OF EVENTS

                 16 December  2003
                          Windows
                 3 rd Tuesday 7:00 PM

 Robert Strader 949-646-11475
robert.strader@comcast.net

23 December  2003
   Digital Cameras / Scanning -

                              4th Tuesday,7:00PM
    David Wintle 714-548-7994

     allart@bacbell.net

                 9 December  2003
                         Hardware
                  2nd Tuesday. 7:00 PM
                           Ed Leckliter
                  eleckliter@adelphia.net

                 2 December 2003
          Internet / Web Publishing

    1st   Tuesday  7:00 PM
     Michael Moore 714-535-0608

                 6 January 2004
          Internet / Web Publishing

    1st   Tuesday  7:00 PM
     Michael Moore 714-535-0608

              president.bod@ocipug.org

                           13 January 2004
                               Hardware
                     2nd Tuesday. 7:00 PM
                              Ed Leckliter
                       eleckliter@adelphia.net

       Sunday -February 1, 2004
                         8:00am to 2:00pm
                     ACP Giant Parking Lot
    1310 E. Edinger Ave. (Grand & Edinger)
                      Santa Ana, CA 92705
                         (714)619-3487

  president.bod@ocipug.org
OCIPUG Hardware SIG - Meeting Recap
Meeting Date: November 11, 2003

There were 17 attendees (including SIG Leader, Ed Leckliter)

Featured Topic(s): Other Components (Modems, NICs, Chassis, Power Sup-
plies, HFAs, Fans, Keyboards, and Mice): 2003 Update and “Using the
Motherboard CD”

Hardware Submissions

 Jim Stolp brought in his HP Vectra Pentium II system.  The system was halting
on boot up and indicating a CMOS problem.  Jim also brought in a downloaded
CMOS clearing procedure.  We followed the procedure and cleared the CMOS
but were still unable to boot through - same error message.  We stopped at that
point.  Ed suggested that Jim again try HP’s online help system and, if still no
help there, to call HP Tech Support.  Jim’s system has a proprietary motherboard,
an obsolete CPU, and SIMM memory modules.  Fixing the problem at the
board level would either require going back to HP for a HP replacement board
or going to current generation, “industry standard” motherboard, CPU, memory,
and chassis and possibly replacing the power supply.

Random Access - there were only 1-2 questions posed verbally, notes not re-
corded.

Next Meeting: December 9, 2003

Next Meeting Featured Topic(s): Your New System (2003 Update): Planning
Phase (the beginning of an updated five-meeting planning, sourcing, and hands-
on assembly series)

Following Meeting: January 13, 2004

Following Meeting Featured Topic(s): Your New System (2003 Update): Sourc-
ing Your Components

File(s) attached - also posted on the OCIPUG Hardware SIG web site (http://
www.edscustomcomputers.com/welcome_to_the_ocipug_hardware_sl.htm)

Presentation slides in Microsoft PowerPoint format (.ppt).

For the latest OCIPUG Hardware SIG info, please check the SIG’s web site or
contact Ed Leckliter (SIG Leader) at eleckliter@adelphia.net.
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Microsoft Goes After Google
Software giant wants to acquire the search company, report
says.
Stacy Cowley, IDG News Service

Microsoft has reportedly approached Google about a potential
buyout of the search technology company.

Mountain View, California-based Google, one of Silicon Valley’s
few business success stories in the post-dot-com era, has been meet-
ing with investment bankers over the last several months and
exploring its options for a public offering.

During that process, Microsoft approached Google to discuss alli-
ance options, including a takeover, according to an article in Friday’s
New York Times.

Not Interested?
Google hasn’t been rushing to take Microsoft up on the offer: Ex-
ecutives there seem to favor a public offering rather than an acqui-
sition, the newspaper reported.

Microsoft and Google declined to provide comment to the New
York Times for its story.

Calls placed to both companies by IDG News Service weren’t im-
mediately returned.

Microsoft has been looking into the Web search market now largely
dominated by five-year-old Google.

While Microsoft has denied plans to enter the paid search industry,
it has increased the staff on its search team to more than 200 and
deemed MSN Search one of the company’s key businesses.

Comdex Faces Competitor
Vendors, customers flock to rival trade shows.

James Niccolai, IDG News Service

With the opening of the Comdex trade show in Las Vegas next
week, a competitor is a short cab ride away. Jupitermedia, a re-
search and events company, is launching a rival show at the Mandalay
Bay Convention Center, and it’s making no secret of its ambition:
to run Comdex out of town.

Jupitermedia announced plans for its show in February, taking ad-
vantage of financial uncertaintysurrounding Comdex organizer
Key3Media Group, which had filed for bankruptcy protection the
same day. While Comdex faced criticism for becoming a sprawling,
unfocused event that didn’t meet the needs of buyers and sellers,
Jupitermedia promises a more intimate gathering focused
specifically on enterprise technology.

On the eve of its show, called Computer Digital Expo (cdXpo), it
has signed up around 50 exhibitors. Its speaker roster includes Pe-
ter Blackmore, head of Hewlett-Packard’s server group, and Darl
McBride, chief executive of The SCO Group. Jupitermedia expects
to attract about 6000 visitors to the event. That would be only a
tenth of the crowdComdex hopes to draw, but still a healthy start
for a show in its first year, according to Alan Meckler, Jupitermedia’s
chairman and chief executive.

“We’ve created a show which we think addresses all the ills of
Comdex. People want smaller, more focused events,” he says.

Exhibitors Defect
Some exhibitors apparently agree. The Canadian government, which
has been a Comdex regular in the past, is this year setting up its
pavilion at cdXpo instead, to showcase about 20 Canadian IT ven-
dors. Representatives decline to discuss their reasons for switch-
ing. IBM, BEA Systems, and SAP America will also be at cdXpo.
Some companies, like IBM, will have a presence at both shows.

Pointing to Comdex’s falling attendance—the show expects about
50,000 visitors this year, down from 125,000 last year—Meckler
predicts its rapid demise. “When trade shows start to shrink, and
shrink rapidly, they don’t come back, and I think that’s what we’re
seeing here,” he says.

Despite his bluster, Comdex is by no means beaten. Key3Media
emerged from bankruptcy in June, changed its name to MediaLive
International, and announced plans for its own smaller, more fo-
cused event for enterprise IT users. It cut the number of exhibitors
by a half from a year ago and is being selective about attendees for
the first time, to ensure a better class of visitor.

It also moved its headquarters from Los Angeles to San Francisco,
to be closer to the heart of the tech industry. The new management
team includes former members of CMP Media, an experienced me-
dia and events company. Its usual lineup of speakers will be at
Comdex, including Microsoft’s Bill Gates, Sun’s Scott McNealy,
and Siebel Systems’ Tom Siebel. Dell, which has been absent from
the show for six years, has returned.

In short, Comdex has seen the error of its ways and has rebuilt
itself as a new type of show, says Eric Faurot, the show’s vice presi-
dent and general manager.

Wisdom in a Bag of Nails
There once was a little boy who had a bad temper. His Father gave
him a bag of nails and told him that every time he lost his temper, he
must hammer a nail into the back of the fence.

 The first day the boy had driven 37 nails into the fence. Over the
next few weeks, as he learned to control his anger, the number of
nails hammered daily gradually dwindled down. He discovered it
was easier to hold his temper than to drive those nails into the fence.
Finally the day came when the boy didn’t lose his temper at all.

He told his father about it and the father suggested that the boy now
pull out one nail for each day that he was able to hold his temper.
The days passed and the young boy was finally able to tell his father
that all the nails were gone. The father took his son by the hand and
led him to the fence.

He said, “You have done well, my son, but look at the holes in the
fence. The fence will never be the same. When you say things in
anger, they leave a scar just like this one. You can put a knife in a
man and draw it out. It won’t matter how many times you say I’m
sorry, the wound is still there.

 “ A verbal wound is as bad as a physical one. Friends are very rare
jewels, indeed. They make you smile and encourage you to succeed.
They lend an ear, they share words of praise and  they always want
to open their hearts to us.”
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“This is year one of the new Comdex. It’s back to basics—under-
standing how to connect the right buyers with the right vendors.
We will only allow companies on the show floor that have products
for the IT marketplace. You won’t see any car companies or mas-
sage chairs,” he says.

New Age Trade Shows
Comdex became wrapped up in the growth frenzy that marked the
dot-com era, when growth took precedence over a viable business
model, Faurot says. When the market collapsed, “the rules of the
game changed for everybody. Just as IT vendors are now having to
prove their value to customers, so too must trade shows,” Faurot
adds.

With that in mind, MediaLive has joined with trade show organizer
CeBIT USA, International Data Group (parent company of PC
World), CMP Media, and other industry players to come up with a
way of measuring attendance at shows accurately. The consortium
of companies will hold its first meeting at Comdex next week.

Faurot welcomes the challenge from Jupitermedia and claims to be
unperturbed.

“The best thing is that it validates the need for an industry event,
and it allows us to be compared to something besides our past,” he
says.

Faurot’s opponent has some pedigree. Meckler’s resume includes
launching the Internet World trade show in 1993, which he grew to
about 70,000 attendees before selling it to Penton Media in 1998,
along with a few media properties, for $274 million. Today his com-
pany runs several trade shows focused on specific industry seg-
ments. They include WiFi Planet, which has been growing quickly.

“I’m looking forward to next week,” he says. “It’s exciting for me
as a businessman.”

Taking Bets
Some analysts say it’s too early to know how the rivalry between
the two shows will play out. Meckler and Faurot seem to agree on
one thing, however: The industry won’t support two concurrent
trade shows in the same town for very long.

“I think right now it’s up for grabs. It’s too early to say with any
certainty what’s going to happen,” says Andy Olsen, a trade show
consultant with Team International Group in Gainesville, Florida,
who attended the first Comdex show almost a quarter century ago.

Comdex remains one of the best-known industry trade shows in the
world, while some people contacted for this story said they had
never heard of cdXpo. On the other hand, a Computerworld poll in
October shows many IT executives are unaware of Comdex’s
makeover attempt, and still consider it too big and glitzy to be worth
their time.

Rob Enderle, a principal analyst with the Enderle Group in San
Jose, California, says the whole idea of trade shows is being called
into question. With higher quality video coming to the Internet,
buyers may no longer feel the need to attend events in person to
find out what’s on offer, he says.

Meanwhile, Faurot and Meckler are gearing up for an important
week.  “I think that only afterwards, when you can sit back and take
a look at what actually happened, will we really know which one
was successful,” Olsen says.

OCIPUG Member:
Kenneth Paeth became a member
June 15 1998 and was our Mem-
bership Chairman taking care of
out roster and mail lables for the
Readme.Doc for many years.

Funeral Service was
Friday November 14 at
Fairhaven  Memorial
Park in Santa Ana

Ken was born February 27. 1928 in Pomona California .
He enlisted in the Marine Corps in 1943 and attended High
Speed Code School in San Diego for 11 months. He served in
the 4th Division in Maui as a radio operator and participated
in action on Iwo Jima from February 19, 1945 to March 15,
1945. He then served with the 6th division in China until 1046,

Ken went to New York in 1948 to attend RCA Institutes. While
there, he met Frieda and they married on august 19, 1950. They
then returned to Southern California where Ken started his
career as a quality engineer.

He devoted many hours to his life to volunteer working with the
Boy Scouts and at Western Medical Center where he served
3332 hours over a 10-year period. He will be remembered for
his kind heart and willingness to lend a hand to his friends and
family

Ken is survived by his wife, Frieda, daughters, Diana (Scott),
Debbie (Dan),  Donna (Don), grandchildren, Fran, Becky, And
Danny, and sister Mamie.

KKKKKenneth Penneth Penneth Penneth Penneth Paeth  1926-2003aeth  1926-2003aeth  1926-2003aeth  1926-2003aeth  1926-2003
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 Could Spam Kill Off E-Mail?
Some users avoid their in-boxes because of the on-
slaught
.Rita Chang, Medill News Service

WASHINGTON—A majority of the United States’ 126 million e-
mail users say they are losing trust in e-mail, and one in four has cut
back usage because of the daily onslaught of spam.

The findings, detailed in a new report by the research organization
Pew Internet & American Life Project, offer yet more examples of
how spam is wreaking havoc on the “killer app” of the Internet and
proving expensive for businesses.

“People just love e-mail, and it really bothers them that spam is ruin-
ing such a good thing,” says Deborah Fallows, author of the Pew
report, “Spam: Hurting email and degrading the Internet environ-
ment.”

Taking a Toll
For many people, spam has compromised the integrity of e-mail, the
report finds. As more e-mail users apply filters to block spam, they
inadvertently block messages from family and friends as well. Oth-
ers note that spam clutters their in-boxes, leading them to overlook
legitimate e-mail. Other highlights from the report demonstrate how
spam is eroding the quality of U.S. consumers’ online experience:

75 percent of e-mail users are concerned that they can’t stop the
flow of spam, regardless of the measures they’ve taken.  70 percent
say spam has made their online experience unpleasant or annoying.
55 percent say they get so much junk e-mail that they struggle to
find the messages they want.  About one in three say the contents of
their in-box are 80 percent spam.  Spam tends to hit personal e-mail
accounts more than work accounts, most of which are subject to
screening mechanisms that block much unsolicited e-mail.

Here to Stay?
The survey results also hint that the unsolicited e-mail blitz will be-
come a mainstay of online life. The fact is, enough people are click-
ing through the spam offers to convince marketers that they are reach-
ing their targets.

Seven percent of e-mail users, or more than 8 million Americans,
say they have ordered a product or service offered in an unsolicited
e-mail. One in three users say they have clicked on a link in unsolic-
ited e-mail to get more information.

Bulk e-mailers say that even a 0.0001 percent positive response rate
constitutes a break-even point, making spam worthwhile, according
to the report. The fact that even a tiny minority of users respond to
unsolicited e-mail raises the question whether some of the messages
offering legitimate products can be labeled spam, Fallows says.

The report also grapples with the definition of spam, noting that a
law would have to accurately define the term to deal with the prob-
lem effectively. Overwhelmingly, users consider spam to be “unso-
licited commercial e-mail from a sender they do not know or cannot
identify,” the report says.

Users also say spam is also a function of content. According to the
Pew survey, 92 percent say adult content is spam, and 89 percent
consider money-making proposals to be spam. Eighty-one percent
consider unsolicited product or services offers to be spam.

Magnitude of Spam
Although the volume of junk e-mail messages is hard to estimate, a
best guess based on other studies suggests that some 15 billion
messages are spam—or about half of the more than 30 billion mes-
sages exchanged daily.

According to the Pew study, filtering company Brightmail recently
measured more than 7.5 million spam attacks, each ejecting be-
tween 100 to millions of individual e-mail messages in each attack.
Despite this volume, users “only see the tip of the iceberg,” the
report states, thanks to ISPs that deflect much of the spam before it
hits subscribers.

America Online and the Microsoft Network, two of the largest ISPs,
report that they divert a daily incursion of 2.4 billion spam mes-
sages from their subscribers’ in-boxes. AOL estimates this volume
translates to an average of 67 messages per in-box per day, or up to
80 percent of its incoming e-mail traffic. According to the report,
all of the major ISPs underwrite “huge outlays for spam control.”
In a separate recent finding reported by USA Today, ISPs’ costs of
managing spam are passed along with an average of a $2 increase
in a subscriber’s monthly Internet service subscription bill.

Costs of Spam
Estimates for spam’s price tag vary broadly, from $50 to $1400 per
worker per year. Its estimated annual costs to U.S. businesses range
from $10 to $87 billion.

Other costs are felt by online businesses that say e-mail marketing
has gotten a bad rap because of spam. These businesses say they’ve
been unfairly lumped with spammers, and that their discreet and
legitimate e-mail marketing and communications are not reaching
their audience because of spam-filtering technology.

Spam has spawned a thriving industry. Businesses compile e-mail
address lists and sell them. Software makers sell inexpensive appli-
cations that enable illegal spam activities, such as disguising sender
identities and harvesting e-mail addresses.

But most legitimate marketers should welcome legislative measures
that would choke off spam, says Nancy Costopulos, a senior direc-
tor at the American Marketing Association, a professional market-
ing association.

“There will be more and more regulation for e-mail, and it will cost
businesses money to comply with the regulations,” Costopulos says.
“But it can’t be a self-regulating industry anymore. I would be glad
if we can eradicate spam so we can break through the noise. All
marketers should be in favor of that.”

Aside from monetary costs, Fallows says spam exacts social costs,
such as increasing restraints in the openness of the Internet. “The
Internet is based on this open system,” she says. “It’s egalitarian
and everyone is accessible. Spam will change that. People will be
less accessible to each other.”

Fallows says the changes are a departure from how the Internet
was intended to operate. With the rise of spam, the Internet will
become “a more protected and closed environment than it is right
now,” she adds.

Dealing With Spam
Most e-mail users are resigned to the incursion of spam into their
online life, the Pew study suggests. For many, it’s just like any other
annoyance, such as telemarketing calls.
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Most people deal with spam messages by deleting them, and more
than 65 percent preempt spam by opting out of e-mail lists. Most
e-mail users are reticent about giving out their e-mail addresses;
73 percent of users surveyed say they avoid providing that infor-
mation.

In fact, using restraint in giving out e-mail addresses is the way
most people try to fight spam, the survey finds. Also, 69 percent
avoid posting their e-mail addresses on the Web, to avoid har-
vesters. About 14 percent use creative screen names to make it
less possible that a computer can generate their e-mail address.

In addition to technological remedies to fight spam, various orga-
nizations, legislators, and lawyers are working to curb the spam
explosion. The Federal Trade Commission, some states, ISPs, and
a few individuals have brought suits against the worst offenders.

In the U.S. Senate and House of Representatives, there are half a
dozen bills pending designed to reduce spam. The Microsoft and
Yahoo are sharing their intelligence to combat spam. Direct mar-
keters and spam-filtering makers have united to develop stan-
dards for dealing with spam. And the liberal Senator Charles
Schumer (D-New York) has found an ally in the Christian Coali-
tion, which supports his antispam legislation.

“E-mail is an important form of communication that Americans
have come to rely on. The study underscores the need for legisla-
tion that gives consumers control over their e-mail boxes,” says
Paula Bruening, a spokesperson for the Center for Democracy
and Technology, a digital civil liberties group.

Twas the Nite of Thanksgiving

Twas the Nite of Thanksgiving But I just
couldn’t sleep I tried counting backwards,
I tried counting sheep.

The leftovers beckoned - The dark meat
and white But I fought the temptation With
all of my might

Tossing and turning With anticipation The
thought of a snack Became infatuation.
So, I raced to the kitchen, Flung open the
door And gazed at the fridge, Full of good-
ies galore.

Gobbled up turkey And buttered potatoes,
Pickles and carrots, Beans and tomatoes.
I felt myself swelling So plump and so round,
‘Til all of a sudden, I rose off the ground.
I crashed through the ceiling, Floating into
the sky With a mouthful of pudding And a
handful of pie.

But, I managed to yell As I soared past
the trees.... Happy eating to all - Pass
the cranberries, please.

May your stuffing be tasty, May your tur-
key be plump. May your potatoes ‘n gravy
Have nary a lump,

May your yams be delicious May your pies
take the prize, May your thanksgiving din-
ner Stay off of your thighs.

Happy Turkey Day
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The September Executive
Board of Directors Meeting
Was held on September 29, 2003, at the Costa Mesa Senior Center.
President Michael Moore called the meeting to order at 7:05 pm,
with eight of the nine officers and directors, past-Treasurer Kevin
Moser, Newsletter Coordinator Robert Walker, and Member Mark
Borison present.  Vice President David Wintle reported that Direc-
tor/Membership Chairman Morris Fier had suffered a stroke but
fortunately with minimal brain damage except for a slight slurring
of speech.

A draft copy of the minutes of the August 2003 Executive Board of
Directors Meeting had previously been e-mailed to all board mem-
bers for their review.  A revised set of minutes was then e-mailed to
all board members, and a second (minor) revision distributed at the
meeting.  In a motion by Director Red Davidson, seconded by Di-
rector Ed Leckliter, and carried, the minutes of the August 2003
Executive Board of Directors Meeting as revised were approved.

President’s Report:   President Michael Moore suggested that we
move the meeting time of the board meetings to just after the Gen-
eral Meetings which are on the last Saturday of the month.  This
may have to be coordinated with the Senior Center to ensure that
we can do this, as the Center is nominally closed after 12:00 noon
on Saturdays.  In a motion by Director Sandi Tierney, seconded by
Secretary Frank Mastroly, and carried, the board meetings will be
conducted after the General Meetings effective with the next Board
meeting which will be on Saturday, October 25, 2003.

President Michael Moore is coordinating with the Senior Center to
get a code for the copier, with OCIPUG paying the Center for the
copies we make.  This item is already provided for in the budget
under Miscellaneous Supplies.

Secretary’s Report:   No report.  Since he was absent at the past
General Meeting Secretary Frank Mastroly was given a copy of the
sign-in sheets for the meeting.  President Michael Moore expressed
the desire to have a consistent set of sign-in sheets for both the
General Meetings and for the SIGs.  The SIG leaders are respon-
sible for the latter, and Frank will e-mail a copy of the Word file for
the General meeting. Director Red Davidson reported that the pro-
ceeds from the September raffle were $50, and the money was turned
over to Treasurer Cheryl Wester.

Treasurer’s Report:   Past Treasurer/CFO Kevin Moser announced
that as of today he had transferred all his responsibilities to incom-
ing Treasurer Cheryl Wester.  Kevin stated his belief that the monthly
report should actually be for the month previous to the board meet-
ing, as by then the accounts can be reconciled through the end of
the month.  No objections were raised to this suggestion.  Consis-
tent with this, Kevin distributed a financial report for the month
ending September 30, 2003.  His report also included copies of
recent bank statements.

Kevin again made his request that a financial review be made ASAP
to ensure that there is a “clean transfer” to incoming Treasurer/
CFO Cheryl Wester.  In a motion by Director Red Davidson, sec-
onded by Secretary Frank Mastroly, and carried, a financial review
is to be performed by a committee appointed by the President and
completed within 60 days. In a motion by Director Ed Leckliter,
seconded by Director Red Davidson, and carried, the financial re-
port as presented was accepted.

Committee Reports:
Program Committee Report:  Director/Program Committee Chair-
man Ed Leckliter distributed a handout summarizing the programs
for the general meetings.  At the September 2003 General Meeting
there were presentations by CorePROTECT (www.coreprotect.com)
on their CoreRestore system restoration hardware and software so-
lution, and by D-Link Systems (www.dlink.com) on their network-
ing products for home and small business users.  Ed expressed his
disappointment that the CoreRestore representative was from sales
and thus was not knowledgeable about all of the details of the prod-
ucts, and in D-Link for not covering wireless products topics as
initially agreed upon.

At the October 2003 General Meeting, the last one that Ed will be
responsible for (see also New Business), ActivePDF
(www.activepdf.com) will make a presentation on and demonstrate
their activePDF composer as a low cost alternative to Adobe Acro-
bat.  There will also be a presentation by Iwill (www.iwillusa.com)
on motherboards and small form factor bare bones systems.  Ed will
e-mail information on both presentations to Newsletter Coordina-
tor Robert Walker as soon as it becomes available. President Michael
Moore is working on setting up a program for the November 22
General Meeting (moved up one week because of the Thanksgiving
Day holiday), while there will be pot-luck on Saturday, December
20.

It was reported that Microsoft has “programs in a box” and could
send a representative if there is a minimum of 50 in attendance.
They perhaps could also donate an X-Box or MP3 player for the
raffle.

SIG Reports:
The October SIG schedule is as follows:
*    Internet and Web Page Design (Michael Moore), 1st Tuesday of
each month.  On October 7 Michael will continue his presentation
on web page design as well as address questions from the audience.

*    Hardware (Ed Leckliter), 2nd Tuesday of each month.  On
October 14 Ed will continue his discussion on what goes into a
computer, with this month covering other components (modems,
network interface cards  (NICs), chassis, power supplies, heat-sink-
fan assemblies (HFAs), fans, keyboards, and mice).  Ed is looking
for ideas on what he should cover in the upcoming months.

*    Windows 9x/XP (Robert Strader), 3rd Tuesday of each month.
On October 21 Bob will continue covering Windows tips and tricks.
He requested that if any one has any problems with Windows to e-
mail him so that   these can be covered at the SIG.

*    Digital Photography and Scanning (David Wintle), 4th Tuesday
of each month.  On October 28 David havean open forum to discuss
issues of interest to the attendees.

SeniorNet Report:
 Secretary Frank Mastroly reported that the next SeniorNet team
meeting will be on Friday, October 24, 2003, at 3:00 pm.  The next
session of classes will begin on Monday, January 12, 2004 and, as
usual, the SeniorNet team is in need of additional coaches, with the
only requirement being to be able to follow what the instructor is
saying and to be one step ahead of the students.

Member Mark Borison reported that he will be conducting a two-
week ($20 fee) workshop on using eBay.  The first session will be
on Wednesday, October 23, starting at 1:30 PM and will cover set-
ting up an eBay account and buying on eBay, while the second ses-
sion will be on Wednesday, October 30,  starting at 1:30 PM and
will cover selling oneBay.
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The SeniorNet team is also considering offering workshops on scan-
ning and burning CDs.  We are also looking for someone who can
teach a course on using Family Tree Maker to process genealogi-
cal data.

Community Service Report:
 Robert Walker reported that he and other local service club presi-
dents attended a luncheon hosted by Jim de Bloom of the “Daily
Pilot” to discuss ways of getting better coverage in the “Pilot.”
Among other items, there was an exchange of club bulletins so
that all could see what the other clubs were doing.  Robert also
reported that the “Pilot” has a room full of surplus computers, and
suggested that OCIPUG form a team to look to see if they can be
of use.

Long Range Planning Committee Report:
Past President Leonard Stein reported that he is on the lookout for
software bargains to be used for our raffle.  Director Red Davidson
reported that he will be absent for the next two meetings, and so
Leonard will sell the tickets at the October and November General
meetings.

Facilities Report, Maintenance, and Improvement:
Continuing work in process.  Director Red Davidson will procure
the cables requested Programs Chairman Ed Leckliter at the Au-
gust Board meeting.

Publications Report:
Newsletter Coordinator Robert Walker reported that the October
Readme.Doc is “ready to go.”  As usual, he wants the SIG leaders
to provide inputs on the most recent as well as the next SIG for
inclusion in the Readme.Doc, preferably by the first of each month.
Director Sandi Tierney conveyed her request (accepted by Robert
Walker) that she be mailed a hard copy of the Readme.Doc.

Webmaster Report:
Per the Bylaws, the President cannot also be the Webmaster, and
thus Member Mark Borison has agreed to take over from Presi-
dent Michael Moore.  Michael has turned over all files and other
related material to Mark. Robert Walker wondered if we should
consider having someone other that InReach host our site consid-
ering the dispute over the amount of server space (see the minutes
of previous board meetings for more information on this issue).
This item remains open.

Membership Committee Report:
 Robert Walker is working with Director/Membership Committee
Chairman Morris Fier on membership status and e-mail addresses.
If e-mails containing the Readme.Doc bounce, Robert will call to
resolve the problem. Robert Walker distributed a few copies of the
latest membership roster and noted that approximately six will be
dropped due to their membership having expired at least three
months ago.  Robert will be working with Morris on sending out
future renewal notices.

Advertisings and Public Relations Report:  No report.

Old Business:
 At the initiation of Kevin Moser, we continued our discussion on
our obtaining liability insurance at a lower rate, e.g. as does Win-
ners.  In particular, Kevin said that he understands that Winners
has $2 million in liability insurance for approximately half of what
we pay for less coverage.  Kevin has turned over all related mate-
rial to Treasurer Cheryl Wester, and Director Sandi Tierney will
assist Cheryl in this effort. Kevin Moser had previously e-mailed
all board members that he had in his possession several boxes of
files related to the office of OCIPUG Treasurer.

 As we are required by law to maintain certain records, it was de-
cided that we would investigate if it were possible to store those
files we must retain in the lower section of the OCIPUG file cabi-
net and then dispose of the remainder.  This was to be taken care of
after the meeting.

New Business:
As Director Ed Leckliter is retiring as Programs Committee Chair-
man, Member Mark Borison assisted by President Michael Moore
will assume these duties.  Newsletter Coordinator Robert Walker
wants a complete calendar for all OCIPUG activities through Au-
gust 2004 for distribution to all board members. Director Sandi
Tierney volunteered to send a card to Director Morris Fier wishing
him a speedy recovery.

Adjournment:
Moved by Director Ed Leckliter, seconded by Director Red
Davidson, and carried.  The meeting was adjourned at 8:20 pm.
The next OCIPUG Board meeting will be on Saturday, October
25, 2003, after the General Meeting (see the President’s Report).

Respectfully submitted,
Frank Mastroly, Secretary

Poem For Computer Users Over 40

  A computer was something on TV
  From a Science Fiction show of note,
  A window was something you hated to clean
  And ram was the father of a goat.

  Meg was the name of my girlfriend
  And gig was a job for the nights
  Now they all mean different things
  And that really mega bytes.

  An application was for employment
  A program was a TV show
  A cursor used profanity
  A keyboard was a piano.

  A Memory was something that you lost with age
  A CD was a bank account
  And if you had a 3 1/2-in. floppy
  You hoped nobody found out.

  Compress was something you did to the garbage
  Not something you did to a file
  And if you unzipped anything in public
  You’d be in jail for a while.

  Log on was adding wood to the fire
  Hard drive was a long trip on the road
  A mouse pad was where a mouse lived
  And a backup happened to your commode.

  Cut you did with a pocket knife
  Paste you did with glue
  A web was a spider’s home
  And a virus was the flu.

  I guess I’ll stick to my pad and paper
  And the memory in my head.
  I hear nobody’s been killed in a computer crash
  But when it happens they wish they were dead
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  Don Edrington’s PC Chat
  San Diego’s North County Times Sunday, November 9, 2003

 Helping to Ensure That a Picture Travels with your Email

  As I’ve said before, I learn more about computers from readers of
this column than from almost any other source. Here’s another ex-
ample: Linda Sides wrote to say that pictures she sends as Outlook
Express attachments sometimes don’t arrive, and the intended re-
cipient just sees a box containing a red X. She went on to say this
can happen whether she uses Insert>Picture or if she clicks the “At-
tach” button.

  However, Linda added, the problem was solved when she discov-
ered she can click on Format>Send Pictures With Message. Thanks
for the tip, Linda!

  Using Word Processing Templates

  Don Davidson wrote regarding a recent column which explained
how to create a page in MSWorks where text could be superim-
posed over a picture. Don pointed out that saving the file as a “tem-
plate” would make the page more readily available each time Works
is launched.

 Templates are a feature of all word processing programs, and can
range from pages that contain some simple pre-composed text to
more complex ones that can guide us through creating a wedding
invitation or filling out a job résumé. If you have a document that
will be used over and over with variable text to be added each time,
you can save it as a template.

In MSWorks, go to File>Save As and choose “Works
Template.WPT” in the “Save As Type:” box. If you name the file,
say, “MyProfile,” it will be saved as “MyProfile.wpt” in the
C:\Program Files\Microsoft Works\Templates folder. When Works
is subsequently launched, “MyProfile” will always be listed under
“Programs” and ready to use.

 If you then add something to the document and then go to File>Save
As, you’ll be prompted to type a new name that will have the de-
fault .WPS (Works Word Processor) extension, and which will leave
your template unchanged.

 Using the “NORMAL” Template

 Going to File>Save As in MSWorks will also display a “Template”
button. Be careful - clicking it will bring up NORMAL.WPT, a pre-
installed template that determines all the word processor settings,
such as its default font style. Do NOT change this template unless
you want all future documents to reflect your new “style” settings.

 Similar options are available in MSWord, which adds the exten-
sion “.DOT” to a template. Also, Word has a “default-settings” tem-
plate named NORMAL.DOT, which can be used to customize those
defaults. If you just want to change the default font, however, it’s
easier to go to Format>Font, choose your preferences and then
click on the “Default” button.

 One final word about MSWord’s NORMAL.DOT file; you may
want to delete it at some point. Word is a super-sophisticated pro-
gram that can do amazing things; but this super-sophistication also
makes it prone to getting out of kilter.

If you ever get an error message that refers to NORMAL.DOT,
it’s best to just delete the file. Go to Start>Find/
Search>NORMAL.DOT. When the file appears, click on it and
hit your Delete key. The next time Word is launched, the file will
automatically be recreated with its original default settings, and
the error message will be gone.

 Dress Up Your Word Processing with WordArt

  A handy tool that is available in both MSWord and MSWorks, as
well as in other MS programs, is WordArt. As its name suggests,
you can do artistic things with a word or a phrase. Go to
Insert>Picture>WordArt. For Works users, a box will appear read-
ing YOUR TEXT HERE. The regular word processing toolbar
will be replaced with a new one that lets you edit the WordArt
“drawing.”

 Click on “Plain Text” and a drop-down window will show a vari-
ety of shapes, such as a waving banner, an arch, and a stop sign.
Click on a design and your phrase will conform to its shape, where-
upon you can edit the drawing by giving it, say, a shadow or a 3D
look.

 Word users will be presented with a “WordArt Gallery” from which
a number of colorful pre-designed drawings can be chosen. Click
OK and a floating WordArt toolbar will give you the options men-
tioned above, along with many others. WordPerfect users have
similar options with TextArt.

 WordArt makes a nice addition to the word processing drawing
tools described in a recent column. Together they are great for
designing colorful Holiday Greetings cards or letters, and some
samples are displayed at www.pcdon.com.

 More PC Tips can be found at www.pcdon.com where archives
of all these newsletters from 2001, 2002 and 2003 can be found,
along with Free Music, Free Software, and all kinds of other in-
teresting things.
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Comdex Faces Competitor
Vendors, customers flock to rival trade shows.
James Niccolai, IDG News Service
Friday, November 14, 2003
With the opening of the Comdex trade show in Las Vegas
next week, a competitor is a short cabride away. Jupiter me-
dia, a research and events company, is launching a rival show
at the Mandalay Bay Convention Center, and it’s making no
secret of its ambition: to run Comdex out
of town.

Jupitermedia announced plans for its show in February, taking
advantage of financial uncertainty surrounding Comdex orga-
nizer Key3Media Group, which had filed for bankruptcy pro-
tection the same day. While Comdex faced criticism for be-
coming a sprawling, unfocused event that didn’t meet the needs
of buyers and sellers, Jupitermedia promises a more intimate
gathering focused specifically on enterprise technology.

On the eve of its show, called Computer Digital Expo (cdXpo),
it has signed up around 50 exhibitors. Its speaker roster in-
cludes Peter Blackmore, head of Hewlett-Packard’s server
group, and Darl McBride, chief executive of The SCO Group.
Jupitermedia expects to attract about 6000 visitors to the event.
That would be only a tenth of the crowd Comdex hopes to
draw, but still a healthy start for a show in its first year, ac-
cording to Alan Meckler, Jupitermedia’s chairman and chief
executive.

“We’ve created a show which we think addresses all the ills of
Comdex. People want smaller, more focused events,” he says.

Exhibitors Defect
Some exhibitors apparently agree. The Canadian government,
which has been a Comdex regular in the past, is this year set-
ting up its pavilion at cdXpo instead, to showcase about 20
Canadian IT vendors. Representatives decline to discuss their
reasons for switching. IBM, BEA Systems, and SAP America
will also be at cdXpo. Some companies, like IBM, will have a
presence at both shows.

Pointing to Comdex’s falling attendance—the show expects
about 50,000 visitors this year, down from 125,000 last year—
Meckler predicts its rapid demise. “When trade shows start to
shrink, and shrink rapidly, they don’t come back, and I think
that’s what we’re seeing here,” he says.

Despite his bluster, Comdex is by no means beaten. Key3Media
emerged from bankruptcy in June, changed its name to
MediaLive International, and announced plans for its own
smaller, more focused event for enterprise IT users. It cut the
number of exhibitors by a half from a year ago and is being
selective about attendees for the first time, to ensure a better
class of visitor.

It also moved its headquarters from Los Angeles to San Fran-
cisco, to be closer to the heart of the tech industry. The new
management team includes former members of CMP Media,
an experienced media and events company. Its usual lineup of
speakers will be at Comdex, including Microsoft’s Bill Gates,
Sun’s Scott McNealy, and Siebel Systems’ Tom Siebel. Dell,
which has been absent from the show for six years, has re-
turned.

In short, Comdex has seen the error of its ways and has rebuilt
itself as a new type of show, says Eric Faurot, the show’s vice
president and general manager.

“This is year one of the new Comdex. It’s back to basics—under-
standing how to connect the right buyers with the right vendors. We
will only allow companies on the show floor that have products
for the IT marketplace. You won’t see any car companies or massage
chairs,” he says.

New Age Trade Shows
Comdex became wrapped up in the growth frenzy that marked the
dot-com era, when growth took precedence over a viable business
model, Faurot says. When the market collapsed, “the rules of the
game changed for everybody. Just as IT vendors are now having to
prove their value to customers, so too must trade shows,” Faurot
adds.

With that in mind, MediaLive has joined with trade show organizer
CeBIT USA, International Data Group (parent company of PC
World), CMP Media, and other industry players to come up with a
way of measuring attendance at shows accurately. The consortium of
companies will hold its first meeting at Comdex next week.

Faurot welcomes the challenge from Jupitermedia and claims to be
unperturbed.

“The best thing is that it validates the need for an industry event, and
it allows us to be compared to something besides our past,” he says.

Faurot’s opponent has some pedigree. Meckler’s resume includes
launching the Internet World trade show in 1993, which he grew to
about 70,000 attendees before selling it to Penton Media in
1998, along with a few media properties, for $274 million. Today his
company runs several trade shows focused on specific industry seg-
ments. They include WiFi Planet, which has been growing quickly.

“I’m looking forward to next week,” he says. “It’s exciting for me as
a businessman.”

Taking Bets
Some analysts say it’s too early to know how the rivalry between the
two shows will play out. Meckler and Faurot seem to agree on one
thing, however: The industry won’t support two concurrent trade
shows in the same town for very long.

“I think right now it’s up for grabs. It’s too early to say with any
certainty what’s going to happen,” says Andy Olsen, a trade show
consultant with Team International Group in Gainesville, Florida, who
attended the first Comdex show almost a quarter century ago.

Comdex remains one of the best-known industry trade shows in the
world, while some people contacted for this story said they had never
heard of cdXpo. On the other hand, a Computerworld poll in Octo-
ber shows many IT executives are unaware of Comdex’s makeover
attempt, and still consider it too big and glitzy to be worth their time.

Rob Enderle, a principal analyst with the Enderle Group in San Jose,
California, says the whole idea of trade shows is being called into
question. With higher quality video coming to the Internet, buyers
may no longer feel the need to attend events in person to find out
what’s on offer, he says.

Meanwhile, Faurot and Meckler are gearing up for an important week.

“I think that only afterwards, when you can sit back and take a look
at what actually happened,will we really know which one was suc-
cessful,” Olsen says.
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            October Board of
             Directors Meeting
The October Executive Board of Directors (Board or BOD)
Meeting of the Orange Coast IBM PC User Group (OCIPUG)
was held on October 25, 2003, at the Costa Mesa Senior Center.
President Michael Moore called the meeting to order at
11:30 am, with six of the nine officers and directors, Newsletter
Coordinator Robert Walker, and Member Mark Borison present.

Note that this Board meeting was conducted immediately after
the October General meeting.  This practice will continue until
further notice, as it eliminates the need for Board members to
make two trips to the Senior Center.

A draft copy of the minutes of the September 2003 Executive
Board of Directors Meeting had previously been e-mailed to all
board members for their review.  Although no comments were
received, Secretary Frank Mastroly noted that he had made two
minor corrections.  In a motion by Director Red Davidson,
seconded by Director Morris Fier, and carried, the minutes of the
September 2003 Executive Board of Directors Meeting as
revised were approved.

President’s Report: — No report.

Secretary’s Report: — No report.

Treasurer’s Report: — No report, as  Cheryl Wester has
resigned due to changes in her work assignments.  In the interim,
Past Treasurer/ CFO Kevin Moser has  turned over all of  his
books and files to Robert Walker, and  will  assist the person who
takes over as much as needed. As we are required by law to
maintain certain records, these files have been stored in the lower
section of the OCIPUG file cabinet.  See also New Business.

Committee Reports:

Program Committee Report: — As noted in the September
2003 BOD meeting minutes, Member Mark Borison, assisted by
President Michael Moore, has agreed to assume the position of
Program Committee Chairman.  At the October 2003 General
Meeting, Member Richard Baznik gave an excellent presentation
on activePDF (a program similar to but not as full-featured as
Adobe Acrobat)  using a PowerPoint  presentation and printed
material  provided by active PDF  (www.activepdf.com).  This
was followed by a presentation by Member Cheryl Wester on
Googology 101 o r “How to Stop Searching and Start Finding,”
using a PowerPoint presentation from  www.netsquirrel.com, a
website created by Patrick Douglas Crispen.

For the November 22 General Meeting (moved up one week
because of the Thanksgiving Day holiday), there will be a
“presentation in a box” on the Intel Centrino Mobile Technology
(CMT) for laptops and, perhaps, a summary of members’
experience at Comdex.  There will be pot-luck on Saturday,
December 20 preceded by a brief in-house presentation still TBD

.

To assist Mark, Robert Walker will e-mail to Mark all he has on
various contacts, including a list of potential presenters from
APCUG, as we need to get back into the APCUG flow.  In
addition, President Michael Moore will e-mail Mark a list of
potential software presenters.

SIG Reports:

The November SIG schedule is as follows:

* Internet and Web Page Design (Michael Moore and
Mark Borison), 1st Tuesday of each month.  On
November 4, Michael and Mark will continue the
presentation on web page design as well as address
questions from the audience

* Hardware (Ed Leckliter), 2nd Tuesday of each month.
On November 11, Ed, who has returned from his trip,
will finish his series on “what is inside the box” and
cover other components (modems, NICs, chassis, power
supplies, HFAs, fans, keyboards, mice), and also what is
on the “motherboard CD.”

* Windows 9x/XP (Robert Strader), 3rd Tuesday of each
month.  On November 18, Robert will continue to cover
Windows tips and tricks.

* Digital Photography and Scanning (David Wintle), 4th
Tuesday of each month.  On October 28 David will
conduct an open forum on scanning and printing.

SeniorNet Report: — Secretary Frank Mastroly reported that
the next SeniorNet team meeting will be on Friday, November
21, 2003, at 3:00 pm.  The next session of classes will begin on
Monday, January 12, 2004 and, as usual, the SeniorNet team is in
need of additional coaches, with the only requirement being to be
able to follow what the instructor is saying and to be one step
ahead of the students.

The SeniorNet team is considering offering workshops on
scanning and burning CDs.  We are also looking for someone
who can teach a course on using Family Tree Maker to process
genealogical data.

Community Service Report: — Robert Walker reported that
this is a continuing work in progress.

Long Range Planning Committee Report: — Mark Borison

feels that we should continue our efforts to hold joint meetings
with other clubs, e.g., Winners, North Orange County, etc.
Director Red Davidson agreed that this needs to be addressed.

Facilities Report, Maintenance, and Improvement: —
Continuing work in process.  Member Steve Schiffman is
evaluating setting up a wireless network for the Center.  As
currently envisioned, this system would use the SeniorNet router
to set up an access point mounted in the ceiling just outside the
computer room (it will need a 120v power supply), with the
installation of network cables between the computer room and
the access point donated by Del Heinz of Comcast, our cable
internet provider   Presently the system being evaluated for the
Center will have four hard-coded MAC addresses for the four
Center computers and thus would not be accessible by other
wireless devices.
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Operations (Policy and Procedures): — No report.

Publications Report: — Newsletter Coordinator Robert Walker
reported that the November Readme.Doc is “ready to go.”  As
usual, he wants the SIG leaders to provide inputs on the most
recent as well as the next SIG for inclusion in the Readme.Doc,
preferably by the first of each month.

Webmaster Report: — Webmaster Mark Borison said that he
wants old copies of the Readme.Doc which he can scan and post
on the OCIPUG web site assuming we can resolve our difficulties
with InReach.  Former Webmaster Michael Moore reported that
he cannot even delete files form the site in order to make room
for new files, and that is why the site has not been updated for
some time.  The problem with InReach remains open.

Membership Committee Report: — Robert Walker reported
that his current membership roster shows 67 members.  We need
a new Membership Committee Chairman.

Advertisings and Public Relations Report: — No report.

Old Business: — None.

New Business:

Past President Leonard Stein has agreed to assume the position
of Treasurer/CFO.  As a result, we will need new bank signature
cards for Leonard, President Michael Moore, and Secretary
Frank Mastroly.  Michael will coordinate this.

Those members attending Comdex were requested to pick up as
much material as they could.

Adjournment: — Moved by Director Red Davidson, seconded
by Treasurer Leonard Stein, and carried.  The meeting was
adjourned at 12:20 pm.  The next OCIPUG Board meeting will
be on Saturday, November 22, 2003, immediately after the
November General Meeting.

Respectfully submitted,

Frank Mastroly, Secretary

Digital Cameras for the Holiday Season
By Ira Wilsker

Whether advertising hype or legitimate analysis, many of the pub-
lished pundits are predicting that this winter will be the prime sea-
son for digital camera sales.  In compliance with traditional techno-
logical history, digital cameras have improved in quality and fea-
tures while plunging in price.  I got a "deal" on my first digital cam-
era three years ago, with 640x480 resolution which is 0.3 (that's
three-tenths) of a megapixel resolution, 10x optical zoom, slow se-
rial connectivity, and 2 megs of memory for $270, about one-half
retail.  For the record, that camera still works fine.  Today our local
retailers are offering technologically superior digital cameras with
10 times the resolution and 16 times the built-in memory, with fast
USB connectivity, for about the same price.  In many markets, digi-
tal cameras far outsell comparable 35mm cameras.  Digital cameras
require no film (only memory), require no processing (no trips to
the photo counter with the concurrent cost of processing), and pro-
vide the instant gratification popularized by the obsolescent Polaroids
of yesteryear.

Two of my daughters expressed an interest in a digital camera for
the holidays so I have been shopping around.  There is a myriad of
techno-babble terms being bantered about in describing digital cam-
eras that may require some explanation here so all can understand.

The primary feature being touted by digital camera makers is
"megapixels" or millions of tiny dots of resolution.  A "pixel" is the
common vernacular for "Picture element", which is each tiny dot of
information that you see on your computer screen.  To put megapixels
in perspective, a computer monitor with the common 800x600 reso-
lution means 800 pixels wide by 600 pixels high, or 480,000 pixels.
Likewise a 1024x768 resolution, common on today's 17 inch moni-
tors, is 786,432 pixels.  If the primary intent is to email digital pho-
tos, or post them to the web, then very high resolutions are unnec-
essary.  Someone recently sent me a huge image file as an email
attachment.  The picture was of a new grandchild, and taken with a
2.1 megapixel camera, at maximum resolution.  The sender did not
practice good "netiquette" and reduce the size of the image to rea-
sonable dimensions (such as 320x240 or 640x480), so his large im-
age was three times the size of the screen on my 17 inch monitor.
The only way to view the unedited image was to scroll left and
right, and up and down.  In most cases there is little need to take
photos at the maximum resolution; almost all cameras allow for
smaller, lower resolution photos.

If the user wants to print the photos with a photo grade printer on
high quality inkjet or laser photo paper, 2.1 megapixels, can pro-
duce an excellent quality 5x7 inch print, and a reasonable 8x10 inch
print.  Many of the moderately priced digital cameras are now being
offered with 5 or more megapixels.  With an appropriate printer and
paper, 5 megapixels can produce an excellent quality 8x10 print,
and a decent 11x17.  The holy grail of digital cameras, 12+
megapixels, the resolution of good quality slide film, was passed
about two years ago by the high-end professional models.  Many
professional photographers, who dismissed digital photography as
a low quality fad a few years ago, are now embracing the new tech-
nology.

The ability to zoom the image in and out is a popular feature in most
cameras.  The two methods of zoom available on digital cameras
are optical and digital zoom.  In terms of sharpness, optical zoom is
superior to digital, as the image itself is manipulated, rather than the
pixels making up the image.  The less expensive cameras typically
only offer digital zoom (adequate for common snapshots), but the
better cameras offer either optical zoom or a combination of the
two.
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The memory available to the camera determines how many images
it can hold before the data must be downloaded to a computer or
other device.  Most digital cameras have some built-in memory,
and allow for the addition of supplemental memory in a variety of
formats.  Some cameras minimize the need for digital memory by
writing the image directly to a floppy disk or mini-CD.  Since the
integral memory in a digital camera can typically hold only a small
number of images, it is important to determine the price and avail-
ability of additional memory in the proper format.  Memory comes
in different capacities and formats from tiny cards, to rectangular
"memory sticks".All camera memory is not the same, and differs in
speed (faster is better, but often at a price), and power consump-
tion (less power consumption is better by prolonging battery life).
According to Lexar, one of the major manufacturers of digital cam-
era media, the number of photos that can be held in memory varies
by the resolution of the photo and the capacity of the media.  If the
inexpensive 32meg memory card is used, at maximum resolution, a
2 megapixel camera will store about 35 images, while only storing
12 images from a 5 megapixel camera.  Media of 256megs (often
around $50) can hold much more; 284 images at 2 megapixels, and
102 images at 5 megapixels.  A chart showing the capacity of dif-
ferent media is available at www.lexarmedia.com/digfilm/
index_cf.html.  It should also be noted that the memory, also re-
ferred to as "digital film", can be reused indefinitely.

Almost all new digital cameras come with some form of fast USB
connectivity to download images to the computer.  Accessories
such as docking stations, and external card readers are a conve-
nience, but not a necessity.

As an added convenience, most local photo finishers now print
photo-grade images directly from the camera memory, at prices
lower than printing them yourself.  Now we can have the best of
both worlds.

Ira Wilsker is the Advisor for Region 8, APCUG Representative &
Bylaws Chair for the Golden Triangle PC Club, a columnist for
The Examiner in Beaumont, Texas, and has two radio shows.  He
also graciously shares his articles with the APCUG editors.

May Your Holidays Be Filled With Polygons
By Timothy Everingham, TUGNET
teveringham@acm.org

Again it is getting cooler; Fall is here and the
holiday season is just around the corner.
While many look forward to, "chestnuts
roasting on an open fire," too many of us
are dreaming of polygons.  Yes, it is the
time for the largest release of games
for computers and video consoles of
the entire year.

This year we have gotten to the point of cin-
ematic quality in games.  Games like Vivendi
Universal's Half Life 2 and Electronic Arts, The
Lord of the Rings: The Return of the King are
up to the standards of what one would expect
in an animated movie.  Some games? artifi-
cial intelligence units which control the ad-
versary units are improving so that after a while the adversary will
pick up on the players tactics and make adjustments, which then
requires the players to change their tactics.

However, some games continue to remain dumb so your enemies
don't even know you are there unless you hit them over the head
with something.

Games based on movies or TV shows continue to be generally bad;
but there are some exceptions, like Electronic Arts, James Bond
series of games.  One trend concerning such games is that some of
those games are directed toward the general population rather than
toward the hard core gamer.  This has lead to some games having
bad reviews by the hard core gaming press and hard core gamers.
But because non-hard core gamers enjoy these games they wind up
as a best seller.  Examples of these are Atari's Enter The Matrix and
Electronic Arts, Harry Potter and The Sorcerer's Stone.

In the game console wars, Nintendo seems to be losing.  Twice this
year Nintendo had to do a special promotion bundling when the
GameCubes sales went significantly lower than Microsoft's Xbox.
Over the last two years Nintendo has had many companies that
exclusively developed for their platform start developing games for
other platforms as well.  This year two well-known game publish-
ers decided to discontinue publishing games for the GameCube.  In
addition, Sony Playstation 2 games are reported to be about 70%
of the console games sold.  Sony and Microsoft built their consoles
with the concept of it not being just a console, but a home enter-
tainment device.  They also had plans for online gaming.  Nintendo
did not on both counts, which has hurt them.  The next generation
of consoles are expected to arrive 2005-2006, and the results may
be a live or die situation for Nintendo as a console manufacturer.

For those who have recently bought or upgraded PCs with good
graphic cards and CPUs and want to show them off with some
great games Vivendi Universal Games, Half Life 2, Electronic Arts
The Lord of the Rings: Return of the King, and JoWood's  AquiNox
2: Revelation are games you should consider.  The Lord of the
Rings: Return of The King will be on the consoles too.

Some good WWII action titles are Electronic Arts,  Medal of Honor:
Rising Sun for the consoles (PC version later on) and for the PC
Activison's Call To Duty. Electronic Arts has again brought out
another of its excellent James Bond series, James Bond Everything
or Nothing (consoles only for now).  Ubisoft' Prince of Persia: The
Sands of Time (PS2) and Tom Clancy's Ghost Recon: Island Thun-
der (Xbox) are definitely worth your consideration.

For you fans of Electronic Arts, Battlefield 1942 (PC) there are the
Secret Weapons of WWII and Road to Rome expansion packs.
The release date for Microsoft's Halo 2 (Xbox) is March 2004, but

the first version of this excellent first person shooter
has now been released for the PC.  Ubisoft's
Beyond Good & Evil (PC & consoles) gives
a unique mixing of game genres to provide
an excellent action adventure.  If you like
survival horror games, try Kononomi?s Si-
lent Hill 3 for the PS2.

For those who like more thoughtful games
look at Microsoft?s Rise of Nations real-
time strategy game (PC).  Electronic Arts
has an expansion pack for its RTS Com-
mand and Conquer Generals, Command &
Conquer Generals Zero Hour.  If you are a
fan of the Sims, there is the Making Magic
expansion pack where spells can produce
love or turn someone into a frog.
Microsoft?s Flight Simulator 2004: A Cen-

tury of Flight (PC) is another title you should look at.



15

For aerial combat look at Microsoft's Crimson Skies: High Road to
Revenge (Xbox) and Lucas Arts, Secret Weapons Over Normandy
(PC, PS2, & Xbox).  For you Star Wars fans there is Lucas Arts,
Star Wars: The Clone Wars (Xbox).

For the sports fans for football game you should look for Madden
NFL 2004 from Electronic Arts (PC & all consoles), which fits the
general rule that Electronic Arts either has the best sports game or
tied for first.  As with all of Electronic Arts sports titles, only the
Playstation 2 version is playable online.

Microsoft's Midtown Madness 3 (Xbox) is a racing through traffic
game.  For a fighting game there is Namco's Soul Caliber II (all
consoles).  If you like shooting things up with your racing try
Midway's Spy Hunter 2 (all consoles).

Then there are games for those who don't want to follow the rules.
Sony's Downhill Domination (PS2) is an off road outlaw bicycle
racing game.  Then as a follow up to their successful Outlaw Golf,
Simon & Schuster Interactive has come up with Outlaw Volleyball
(Xbox).  Of course for those who really want to go outlaw, Rockstar
Games? Grand Theft Auto: Vice City is now available for the PC.

If you are looking for a massively multiplayer online game, Sony
Online Entertainment's Planetside (PC) is a breakthrough on game
play and realtime graphics.  SOE has also come out with an "All
Access" subscription where you can play all their MMOG for $21.95
a month.

A joint venture with Lucas Arts, Star Wars Galaxies: An Empire
Divided (PC) got off to a slow start, but many of the bugs have
been fixed and it is becoming quite popular.

Square Enix's Final Fantasy Online XI also looks good (PC & PS2).

For many of you there will be polygon this holiday coming through
your game platform.  In many cases games are getting better, but
some think they can get away with doing more marketing and tying
to films or TV shows to overcome bad game design.  So check the
reviews and your friends to know where to best put your cash.  If
you are really in a quandary, you can always rent them first at your
local video store.  Remember to play with respect and thoughtful-
ness and to destroy the alien before it eats you.

Timothy Everingham is CEO of Timothy Everingham Consulting in
Azusa, California.  He is also Vice Chair of the Los Angeles Chap-
ter of ACM SIGGRAPH, the largest chapter of the Association for
Computing Machinery's (ACM) Special Interest Group on Com-
puter Graphics and Interactive Techniques and one of Southern
California's significant professional organizations within the enter-
tainment and media industries. In addition he is the Vice President
of the Windows Media Users, Group of Los Angeles. He is also
part-time press in the areas of high technology, computers, video,
audio, and entertainment/media and has had articles published
throughout the United States and Canada plus Australia, England,
& Japan. He is a member of TUGNET. Further information can be
found at http://home.earthlink.net/~teveringham

General Meeting, October 25
The October 2003 General Meeting of the Orange Coast IBM PC
User Group (OCIPUG) was held on Saturday, October 25, 2003, at
the Costa Mesa Senior Center, with 27 members in attendance.

All members in attendance were reminded by Secretary Frank
Mastroly to sign in and to note on the sign-in sheets any e-mail ad-
dress changes and also if they did not receive the e-mailing of the
October 2003 Readme.Doc.  In addition, it was requested that all
names and e-mail addresses be printed on the sign-in sheets, as News-
letter Coordinator Robert Walker is continuing to updatehis mailing
list and needs this information ASAP.  Robert is still receiving
“bounces,” which he then has to follow up by phone due to members
having new e-mail addresses.  Robert also had a separate sheet on
which members could indicate any changes to address, phone num-
ber, and/or e-mail address.

There was no Random Access (Q&A) session.

President Michael Moore called the General Meeting to order at
9:10am.  Michael started the meeting by thanking member Mark
Borison for volunteering to be Webmaster and Program Committee
chairman, and thanking member Steve Schiffman for volunteering to
conduct the hardware SIG in the absence of Ed Leckliter who is out
of town.

Michael announced that the October OCIPUG Board of Directors
meeting would be conducted immediately after this General meet-
ing.  This will be normal operating procedure until further notice.

Because of changes in her work assignments, Cheryl Wester has re-
signed as Treasurer/CFO, and anyone interested to assume this of-
fice should contact Michael after the meeting.

Secretary Frank Mastroly reported that he had learned that former
OCIPUG Secretary Pat Cohen was suffering form abdominal can-
cer, but that he had seen her regularly in church.  He will advise
the membership of any updates in Pat’s condition.

Member Mark Borison reminded the membership that any new or
renewal subscriptions to Smart Computing Magazine should note
that these subscriptions are to be credited to OCIPUG so that we
can receive free subscriptions and other free items from Smart Com-
puting.  Mark also requested any ideas members may have for pro-
grams and for the OCIPUG web site.

Past President Leonard Stein asked if anyone was interested in pur-
chasing the book “Secret Guide to Computers for $10 plus S&H.  If
so, see Leonard after the meeting.  This book is unique in that the
author puts his phone number on the cover, and President Michael
Moore said that he has talked to the author on occasion.  Newsletter
Coordinator Robert Walker requested a brief write-up on the book
for the Readme.Doc.

In response to a question from President Michael Moore, Ron Perkins,
Frank Mastroly, Mark Borison, and Cheryl and Karl Wester are plan-
ning to attend the APCG Fall meeting and Comdex in Las Vegas
from November 15 through November 20.  Cheryl will be present-
ing a workshop on the Pocket PC on Saturday morning November
15.

The next item of business were the SIG Reports as follows:
*    Internet and Web Page Design (Michael Moore), 1st Tuesday of
each month.  On  November 4, Michael will continue his presenta-
tion on web page design as well as address questions from the audi-
ence
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*    Hardware (Ed Leckliter), 2nd Tuesday of each month.  On
November 11, Ed, who has
     returned from his trip, will finish his series on “what is inside
the box” and cover other
     components (modems, NICs, chassis, power supplies, HFAs,
fans, keyboards, mice), and
     also what is on the “the motherboard CD”..
*    Windows 9x/XP (Robert Strader), 3rd Tuesday of each month.
On November 18, Robert
     will continue to cover Windows tips and tricks.
*    Digital Photography and Scanning (David Wintle), 4th Tues-
day of each month.  On
     October 28 David will conduct an open forum on scanning and
printing.

President Michael Moore then started the main portion of the meet-
ing.  Initially, Nicole Diaz, Desktop Manager at activePDF
(www.activepdf.com) was to give a presentation on the “activePDF
Composer”.  However, Ms. Diaz was unable to attend, but Mem-
ber Richard Baznik gave the presentation using a PowerPoint pre-
sentation and printed material provided by activePDF.  The mate-
rial that follows was taken from both the presentation and from
material on the activePDF website.

PDF (Portable Document Format) is a cross-platform format that
allows one to view and print various test and graphics on a variety
of hardware and operating system platforms.  The PDF
format allows for precise display and print control, and document
security.  Generally, the user can only view and save a PDF file but
cannot alter it in any way.  Portions of a PDF file can frequently be
extracted and copied into another document, but the original file
remains as-is.

Adobe established and published the specifications for creating and
using the PDF format for document sharing.  However, Adobe
Acrobat is not the only program available for creating PDF files.
Affordable and flexible, activePDF Composer simplifies high-quality
desktop PDF creation. Built-in configurations and Microsoft Of-
fice integration streamline PDF conversion, while robust settings
give users full control over PDF output.  ActivePDF Composer
will convert any printable
document to the PDF format.  The program uses most of the key
functions but not all of the options of Adobe Acrobat.  It will pro-
duce PDF files optimizedfor press (formal publishing), print (nor-
mal home user) and web.

Key Features of activePDF Composer include:
* ‘Print’ to PDF from virtually any Windows application
* Supports drag and drop Postscript and EPS to PDF conversion
* Create Intelligent PDF from Microsoft Word and PowerPoint
(see below)
* Optimized settings for press, print and web output (see below)
* Option to save user-defined output configurations
* Enables faster web viewing of PDFs (linearization) (see below)
* Automatically attach PDF and send via email
* Customized file save options for outputted PDFs
* Add document security with 40 or 128 bit PDF encryption
* ‘Send to ‘ PDF from Windows Explorer
* Compression of images and text
* Execute another application on completion of PDF creation pro-
cess
* Color Management and True type font support
* Conforms to latest PDF specification from Adobe  Systems
* Output is compatible with version 3.0 and higher of Adobe Reade

With “Intelligent PDF” files, document structure elements from
the authoring application are converted to dynamic navigation el-
ements in the created PDF file.

 ActivePDF Composer creates Intelligent PDF files from Microsoft
Word and PowerPoint, converting headings to bookmarks, trans-
forming table of contents, footnotes and indexes into PDF links,
and configuring hyperlinks to launch the user’s browser.  Addition-
ally, Microsoft Word comments are converted to PDF “sticky notes”.

The user must select the form of output (press, print, or web) prior
to the conversion.  The program optimizes settings for press, print
and web output.  For reference, press has a resolution of 2,450 dpi,
print has a resolution of 600 dpi, and web has a resolution of 72 dpi,
with corresponding differences in final file sizes.

Composer incorporates PDF linearization, which optimizes PDF files
for more efficient viewing over the web.  Pages can be viewed as
they are being downloaded, rather than forcing the user to wait while
the entire PDF file is downloaded.

Composer includes a myriad of settings allowing the user to opti-
mize the PDF files depending on the intended output device.  Ad-
vanced color management and prepress options are available if send-
ing files to a commercial printer, while image compression and font
embedding options allow the user to reduce file sizes without com-
promising visual quality.  Font embedding allows the user to use
“rare” fonts that the recipient’s reader may not support.  The user
can choose either to include the entire character set or only a sub-
set of only those characters actually used.  The PDF files will dis-
play and print exactly as intended to, on any device, in any working
environment.

The user can also set security options, including password protec-
tion if desired.  This can range from allowing the recipient to only
view and not print or save, to allowing the recipient to almost any-
thing short of editing and reissuing the file.

At the end of his presentation, Richard distributed evaluation CDs
to all in attendance.  These CDs contain the entire program and are
not time limited.  However, all pages of PDF documents created
using this CD are watermarked.  The program retails for $79, but is
available to user group members at a 25% discount, or for $60.

Initially for the second presentation, Iwill USA’s (www.iwillusa.com)
was to make a presentation that would include company background,
general stats on the company in the marketplace; and detailed dis-
cussion of Iwill motherboards and SFF barebones and what makes
them unique and their products compelling in the marketplaces they
serve; and, finally, a brief description of the company’s operations
in southern California.

However, no representative from Iwill was able to attend.  Instead,
Member Cheryl Wester gave a very informative presentation on
“Googology,” or “How to Stop Searching and Start Finding.”  The
presentation used a PowerPoint presentation downloaded from
www.netsquirrel.com, a website created by Patrick Douglas Crispen.
NetSquirrel.com is the personal Web site of Patrick Douglas Crispen
and is named in honor of the squirrels on the campus of the Univer-
sity of Alabama who so bravely — and routinely — gave their lives
to disrupt power to the University’s mainframe computer center.

To view the presentation (it requires that you have a PowerPoint
viewer available as a free download from Microsoft at http://
office.microsoft.com/downloads/2000/Ppview97.aspx) go to the
NetSquirrel home page and scroll down to Classroom
Resources,which are free PowerPoint presentations that can be used
in the classroom.

 Among these is Google 101 “Stop Searching and Start FINDING.”
The presentation description as taken from the web site states “Sick
and tired of looking for information about the Civil War and ending
up with 1,247,672,286 hits for stuff like sheet metal fasteners or
naked pictures of Ernest Borgnine?
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 This presentation is for you!  In this one hour presentation you’ll
learn the advanced searching tips and techniques that will help you
actually FIND what you are looking for on Google.”  The follow-
ing material was taken from
several of the PowerPoint slides in the Google 101 presentation.

The goal of this presentation is to:
*  Discover the biggest mistakes made by most Internet users
*  Talk about the differences between directories and search en-
gines (and when to use each)
*  Learn some advanced Google searching techniques
*  DO THIS ALL IN PLAIN ENGLISH!

Particular Items of Note Are:
*  The top 15 search terms in 2000 were Sex, Hotmail, Yahoo,
Pornography, Chat, MP3,
   Horoscopes, eBay, AOL, Games, Maps, Pokemon, Nude, Mu-
sic, and XXX.  For an updated
   list, go to www.wordtracker.com
*  The biggest mistake is typing the search terms in the wrong box
*  The second biggest mistake is using the wrong tool at the wrong
time.  Restated, it is using
   a directory as if it were a search engine (and not understanding
why you cannot find  anything).  Remember, YAHOO IS NOT A
SEARCH ENGINE   IT IS A DIRECTORY (also  known as a
Portal).  Directories are usually manually compiled guides to the
web, where  sites are organized by category.  Major directories are
MSN, Yahoo, and Netscape ODP.
*  The third biggest mistake is not knowing how to use directories
or search engines to actually find stuff.

Related to this are the Five Rules of Using a Search Engine:
*  Rule Number One:  Be specific, because if you are not specific
you will end up with a bunch of garbage
*  Rule Number Two:  Use quotes to search for phases (‘patrick
crispen”)
*  Rule Number Three:  Use the plus sign to require (crispen
+pepperdine)
*  Rule Number Four:  Use the minus sign to exclude (crispen -
roadmap)
*  Rule Number Five:  Combine symbols as often as possible
(+”patrick crispen” -roadmap+pepperdine)

Advanced Google searching is simple as long as you remember a
few simple commands
*  Title searches at Google allow you to search for pages that have
a particular word or phrase
   in their title (intitle:moon or intitle:”moon landing”)
*  Site searches at Google allow you to limit your search to only
pages within a specific site or domain, or to exclude pages from a
specific site or domain (apollo site:nasa.gov or apollo site:nasa.gov)
This is an especially powerful tool if trying to locate information on
the Microsoft Knowledge Base.  For example, if you want to find
information on Outlook Express Mail Files you would type
+outlook+express+mail+files site:support.microsoft.com
*  URL searches at Google allow you to search for pages that have
a particular word or phase in their URL, especially when you can
only remember one word in a long URL (inurl:apollo)
*  Related searches at Google allow you to search for pages that
are similar to another page. For example, you can do a related
search to find pages similar to the netsquirrel.com page
   (related:netsquirrel.com)

Putting these all together, a sample advanced Google search could
look like: +inurl:apollo +moon -”john young” +site:nasa.gov (of
course all on one line)

For those interested taking your Googling to the next level, there
is also a course entitled Google 201: Advanced Googology.  Be-
yond the world of plusses, minuses, and quotes lies a whole
universe of secret Google tips, techniques, and tools. This quick,
one-hour workshop introduces you to little known Google fea-
tures like pipes, stop-word workarounds, full-word wildcards, and
query modifiers — features that will instantly make you the envy
of your friends and the center of attention at cocktail parties

On the Patrick Crispen site, there is a link to another very good
source of information on search engines (Search Engine Watch at
www.searchenginewatch.com).  This site contains considerable in-
formation on how search engines work as well as tips on how to
use search engines better.

The following summarizes some of the information that can be
found on this site.
*  How Search Engines
*  How Search Engines Rank Web
*  Web Searching Tips — This section of Search Engine Watch
provides tips on using search engines better, along with some fun
facts such as what people search for on search  engines.
   Using Search Engines Better
*  Search Engine Math — How to use simple commands to im-
prove the results you get from search engines.
*  Power Searching For Anyone — A summary of how to do ad-
vanced searches with the major  search engines, including field
searching.
*  Search Assistance Features — A summary of how to do ad-
vanced searches with the major  search engines, including phrase
searching.
*  Search Features Chart — A one page summary of major search
commands and operators at various search engines, plus a com-
parison of special search features.
*  Search Links: Search Engines Worldwide — Search Links is a
collection of search engines,
   ranging from the major global search engines to those designed
for kids
*  Search Engine Tutorials — Links to tutorials, guides, articles,
and resources to help you use search engines better
*  Search Toolbars & Utilities — Covers search toolbars, compan-
ions, and utilities that let you  access search engines, meta search
utilities, and other programs to help with searching.
*  Boolean Searching — Explains how to use Boolean commands
and operators on the major search engines.
*  Search Engine Reviews — Reviews of search engines and ar-
ticles that offer a behind-the-scenes look at how they work.
*  Search Engine Glossary — Definition of terms relating to search
engines, such as phrase search, Boolean operators, stop words
and more.

The meeting was concluded with our raffle.  Among the winners
and the items selected were:
*  Red Davidson   activePDF Composer
*  Jeff Boquette   Jukebox Program and Web Bambooli
*  Cheryl Wester   Learn Front Page CD
*  George Thuro   Cyber Savers
*  Mark Porter   Hot Prospects
*  Eugenia Frerichs   HR Program

For the November 22 General Meeting (moved up one week be-
cause of the Thanksgiving Day holiday), there will be a “presenta-
tion in a box” on the Intel Centrino Mobile Technology (CMT) for
laptops and, perhaps, a summary of members’ experience at
Comdex.

There will be pot-luck on Saturday, December 20 preceded by a
brief in-house presentation still TBD.
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 How many dogs does it take
     to change a light bulb?”
Golden Retriever:
The sun is shining, the day is young, we’ve got our whole lives
ahead of us, and  you’re  inside worrying about a stupid burned
out  bulb?

Rottweiler:
Make me.

Boxer:
Who cares? I can still play with my squeaky toys in the dark.

Lab:
Oh, me, me!!!!! Pleeeeeeeeeze let me change the light bulb! Can I?
Can I? Huh? Huh? Huh? Can
Can I? Pleeeeeeeeeze, please, please, please!

Border Collie:
Just one. And then I’ll  replace any wiring  that’s not up to code.

Dachshund:
: You know I can’t reach that stupid lamp!

Australian  Shepherd:
 First I’ll put all the bulbs in a circle...

German Shepherd:
 I’ll change it as soon as I’ve led these people from the dark, check
to make sure I haven’t missed any, and make just one more perim-
eter patrol to see that no one has tried to take advantage of the
situation.

Jack Russell Terrier:
 I’ll just pop it in while I ‘m bouncing off the walls and furniture.

Old English Sheep Dog:
Light bulb? I’m sorry, but I don’t see a light bulb...

Cocker Spaniel:
 Why change it? I can still pee on the carpet in the dark. (Also
applicable to Shi-tsus)

Chihuahua:
Yo quiero Taco Bulb.

Pointer:
I see the burned out bulb, there it is, there it is, right there.....

Greyhound:
It  isn’t  moving. Who cares?

Poodle:
I’ll just blow in the Border Collie’s ear and he’ll do it. By the time
he  finishes  rewiring  the  house, my nails will be dry.

The Cat:
Dogs do not change light  bulbs. People change light bulbs. So, the
real question is: How long will it be before I can expect some light,
some dinner, and a massage?

All of which proves, once again, that while dogs have
masters, cats have staff.

A tourist walked into a pet shop and was looking at the animals
on display.

While he was there, another customer walked in and went over
to a cage at the side of the shop and took out a monkey.

He fit a collar and leash, handed it to the customer, saying,
“That’ll be $5000.” The customer paid and walked out with his
monkey.

Startled, the tourist went over to the shopkeeper and said, “That
was a very expensive monkey. Most of them are only a few
hundred dollars.

Why did it cost so much?”

The shopkeeper answered, “Ah, that monkey can program in C
- very fast, tight code, no bugs, well worth the money.”

The tourist looked at the monkey in another cage. “That one’s
even more expensive - $10,000! What does it do?”

“Oh, that one’s a C++ monkey; it can manage object-oriented
programming, Visual C++, even some Java. All the really use-
ful stuff,” said shopkeeper.

The tourist looked around for a little longer and saw a third
monkey in a cage of its own. The price tag around its neck read
$50,000. He gasped to the shopkeeper, “That one costs more
than all the others put together! What on earth does it do?”

The shopkeeper replied, “Well, I haven’t actually seen it do
anything, but it says it’s a consultant.”
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Publication Guidelines
All material submitted will be published exactly as submitted, but

may be subject to editing at the Editor's discretion.  We reserve the right to
refuse any material submitted for publication.  Send all submissions as fol-
lows:

1. Send via Internet e-mail to: editor Robert Walker  949-642-5997
    rwalker820@msn.com and newsletter coordinator

               Michael Conway  714-962-2194  mchbca@aol.com

2. Mail a 3.5” disk  so as to be received by the deadline by the
                Newsletter Coordinator at the OCIPUG mailing address above.

3. Hard copy to Editor at the OCIPUG mailing address above.

Membership
Benefits of OCIPUG Membership include, but by no means are limited to:

* Subscription to OCIPUG’s monthly newsletter, Readme.Doc, with up-
to-date information on meeting schedules as well as the newest software and
hardware.

* Free monthly General Meetings with speakers from industry and
academia describing advances in technology.

* Free Special Interest Group (SIG) meetings/seminars to exchange tips
and tricks and to solve problems.

* Free technical support from knowledgeable fellow members via
telephone and/or e-mail.

* Pleasure in helping your fellow member solve their problems.
* Camaraderie with those of similar interests.
* Discounts from vendors on software, hardware, and other items.

Orange Coast IBM PC User Group
2973 Harbor Blvd  Box 621

Costa Mesa, CA 92626-3934

Membership status: [  ] New  [  ] Renewal - Member #________            Membership type: [  ] Individual   [  ] Family

Title:  Mr.   Mrs.  Ms.   Dr.   Prof.   Hon. (      ) (Circle one)

First Name: ___________________________                Last Name:______________________________

Street Address: _____________________________    City:________________ State: ___ Zip:________

Home Phone:(      )________________  Work Phone: (      )______________  Fax: (      ) ____________

E-mail address: ________________________________________________________

Profession/Trade: ______________________ [  ] Retired  [  ] Current  Occupation:  _______________

Family Member(s) Names: _____________________________________  Company:  _______________

Annual Dues:
Make check payable to OCIPUG                Individual $30.00 $ _______
and mail to the above address Family $35.00 $ _______

or bring to the General Meeting. *Full-time student               $20.00 $ _______
Donation                 $ _______

I consider my skill level to be:
[  ] Beginner   [  ] Novice   [  ] Intermediate   [  ] Advanced  Total Amount Paid $ _______

*(U-grad 12 units; grad 6 units)

I  learned about OCIPUG from: _______________________ Today’s Date : __________________

OCIPUG, founded in 1985, is an independent California nonprofit (IRC
501-c-3) corporation, and is not affiliated in any way with IBM, any
vendor, equipment manufacturer, or other organization.

Publication Copyright © 1985
A newsletter, Readme.Doc, is published monthly.  A subscription of $12
per year is included with all paid memberships. Address all inquiries,
address changes, and material for publication to the above address
marked   “ATTN: Editor”.

Opinions expressed by the authors are not necessarily those of this
newsletter, its staff or OCIPUG.  Mention of products does not constitute
endorsement by OCIPUG.  Omission of trademarks does not imply that
the products or names are not so protected.  Readme.Doc, its
contributors, and staff assume no liability for damages arising out of the
publication or non-publication of any advertisement, article, or any other
item in this newsletter.

Permission is granted to other user groups to reprint herein material, not
specifically copyrighted, for non-commercial use only, provided credit is
given to Readme.Doc and to the author.

Publication Deadline

      Material for the January 2004 issue must be
           received on  or  before December  30, 2003

(OCIPUG) © 1985

E-mail   president.bod@ocipug.org

Mailing Address                                Meetings Loction

Orange Coast IBM PC User Group
Costa Mesa Senior Center
695 West 19th Street
Costa Mesa Ca, 92627
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